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Use of ICT to assess reading in National 3 & 4 Literacy

Human readers are not permitted as a reasonable adjustment when learners are required to show
evidence of their reading skills in SQA National Literacy Units (see http://www.sqa.org.uk/sqa/64698.html)
but the use of ICT is allowed:

“In order to minimise the disadvantage faced by some disabled learners in attaining the National
Units in Literacy, the use of word processors and other assistive technologies such as screen readers,
spell checkers or speech-recognition software would be acceptable as reasonable adjustments.”
(Specification 3 - Literacy Units http://www.sga.org.uk/sqa/64702.html)

Teachers, parents and learners have asked how ICT can be used to support assessment of Literacy and in
this guide we will look at some methods. (We are also writing a guide on ICT alternatives to scribes, for
assessment of writing, which will be made available on the CALL Digital Assessment web site.)

The task - meeting the standard for National 3 Literacy Reading

The National 3 Literacy Unit Specification states that:

“The purpose of this Unit is to develop the learners’ reading, listening, writing and talking skills in a
variety of forms relevant for learning, life and work. Learners will develop the ability to understand
simple ideas and information presented orally and in writing. Learners will also develop the ability to
communicate ideas and information orally and in writing with technical accuracy.””

If we look specifically at the reading assessment standards, the required outcome from the Unit is that:
“The learner will:
1 Read and understand simple word-based texts by:

1.1 Selecting and using relevant information
1.2 Identifying audience and purpose
1.3 Showing awareness of effectiveness” .

The actual text itself that learners will read should:

e “contain a few ideas or sets of ideas;
e contain familiar vocabulary;

e use simple expression.” >**®

Note that assessment of literacy at National 3 or 4 is not ‘an exam’ — it is expected to be carried out in class
as part of the learning and teaching programme.

! National 3 Unit Specification: Literacy (National 3): H23W 73 http://www.sqa.org.uk/sga/47502.html
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An example of how a teacher might obtain evidence of reading ability is given in SQA’s Literacy 3 Unit

Support Notes > *2;

Assessment Outcome 1 1.1 Selecting and 1.2 Identifying 1.3 commenting

evidence using relevant audience and on effectiveness
information purpose

Learner writes Read and Questions ask for Questions ask Questions ask

answers to understand key information on | about the audience | learner to

guestions about an simple word- the website and purpose of the | comment on the

information website | based texts website layout of the

he/she has read website

Having read the text, a learner demonstrates their understanding of the text by answering questions about
it. The learner might give their response by for example:

¢ hand-writing;

* typing;

e dictating to a scribe;

¢ recording their answers as audio or video using a hand-held recorder;

e recording their answers as audio or video directly into the computer.

Making Literacy assessment accessible

SQA provide three example assessment packages that include sample texts and question on their secure
web site. The exemplars are Word files and so if a teacher was using these, s/he could for example:

e print the text out on white or coloured paper;
¢ enlarge the text using a photocopier;

e copy the text and give it to the learner as a Word file, for reading on a laptop, tablet, iPad, mobile
phone etc;

¢ change the font and font size and then print it out, or give the adapted digital file to the candidate
to read on a computer or other device;

e ask the local authority visual impairment transcription service to convert the file into Braille;
e convert the Word file to another format such as PDF or AZW (e.g. for reading on a Kindle).

In many cases subject teachers will be using assessment materials that they have created themselves,
which are usually word processed files. The methods listed above could also be used to make these
assessments accessible.

Reading with ICT

The SQA exemplars must be kept secure, and so we will use some text from the Scottish Government’s ‘Eat
Healthier’ web site® to illustrate how text from a web site could be accessed using ICT.

? Unit Support Notes — Literacy (National 3), http://www.sga.org.uk/sqa/47502.html

® http://www.takelifeon.co.uk/eat-healthier/ . Copyright © 2008-2013 Scottish Government.
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Healthy still means tasty.

You don'thaveto starve your taste buds of flavour just because
you're eating healthily. Many of our favourite foods are both
delicious and nutritious andthere’s awide range of healthy, tasty
food youcan rustle up in nextto no timeand on a budget. Here

youllfind plentyof simple and mouth wateringideas for breakfast
lunch and dinner and even for snacking in between.
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Easy Ways to 5 A-Day
It may sound a lot, but there are plenty of easy ways to squeeze in b portions of fruitand
veg into your daily diet. Thiswill make it easier foryouto take life on, onestep at a time.

Fruit Juice

Chooseyour favourite fruit juice to go with breakfast. It's tasty, it's
refreshing andit's also one of your 5 a day. You can anly countthis as one
though, no matter how much you drink.

With Cereal
If youhave a bowl of cereal for breakfast, try adding chopped fruit like an
apple banana or berries. That's another portion already.

Canned & Frozen

Canned and frozen veg count as well, so try peas, sweetcorn and carrots.
Adding canned chickpeas or kidney beans to a salad or soup will really
helpfill youup, while also counting towards your ba day.

Fresh Fruit
If you're going to be out, carry a couple offresh pieces of fruit in your bag
for mid-morning or afternoon snacks.

i Side Salad
\ b If youmake a habit of having salad withdinner, you'll clockup another
| portionwithout even noticing it. Asmall bowl of salad counts as a portion
w towards your 5a day.
Sandwich

If youadd tomatoes, lettuce or cucumber to your sandwiches
at lunchtime it can help you cutdown on spread or mayonnaise. Be
generous with your salad and itll add another porttiontowards your ba

day.
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Figure 1: Example text on healthy eating, in Microsoft Word
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Reading text using a Windows PC

The text is a Word file, and so there are many ways for a learner with a reading or physical access difficulty
to access it. The examples below are all done using Word 2010; other versions of Word have similar
accessibility features.

Make the text larger or smaller

Many learners with visual impairment or a reading difficulty, including dyslexia, benefit from a bigger font
size.

e C(lick View > Zoom to zoom in to make the text larger, or use the slider in the bottom right corner,
or hold down CTRL and scroll the mouse.

¢ Click View > Web Layout and then zoom in to choose a large font size. Web layout will reflow the
text so that you don’t have the scroll left and right if you have high levels of magnification.

Change the page background and text colour

Learners who have visual stress or dyslexia may find text on a coloured background easier to read. Some
learners with visual impairment may need a high contrast colour scheme (e.g. yellow on black) as well as
magnification.

e Click Page Layout > Page Colour and choose a different page background.

e Select all the text (CTRL-A), click the Home ribbon and choose a different text colour.
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Fruit Juice
B3 | Choose your favourite fruit |
juice to go with breakfast.
| | - | It's tasty, it's refreshing and
iR ~ | it's also one of your 5 a day.
P You can only count this as
one though, no matter how
much you drink.

Figure 2: Web layout with zoom at 500%, pale orange background and black text
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Change the font, font size and line spacing

Some learners find it easier to read text in particular fonts, or to see a larger font size:
¢ Select all the text (CTRL-A), click Home and choose a different font and/or font size.

Many learners with a visual impairment, visual stress, visual tracking problems or dyslexia can read more
comfortably and fluently when each line of text is spaced further apart:

¢ Select all the text (CTRL-A), click Home and then the Line and Paragraph Spacing button, and
choose the line spacing you want (try 1.5 or 2.0 for line-and-a-half, or double spacing).
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Healthy still means ta

You don't have to starve your taste : -y
T buds of flavour just because ’,w
: you're eating healthily. Many of our |

favourite foods are both delicious and nutritious and
there’s a wide range of healthy, tasty food you
can rustle up in next to no time and on a budget.

14 Here you’ll find plenty of simple and mouth watering

ideas for breakfast, lunch and dinner and even

[l for snacking in between. v

Figure 3: Reading text with Verdana 18, coloured background, and double line spacing

Reading the text with text-to-speech software

Although human readers cannot be used to read the text when assessing reading for National 3 literacy,
learners with reading difficulties can use text-to-speech software on a computer, tablet, iPad, smart phone
or Kindle.

There are many text-to-speech programs you can use to read text from a Word document, and we’ll look at
just two of them here by way of example. These tools are both free.

Text-to-speech programs need voices installed on your computer. Your PC will probably have one or two
voices already installed, but the standard voices have American accents, so we recommend using the free
Scottish computer voices from the web site at http://www.thescottishvoice.org.uk/. These are high quality

male (‘Stuart’) and female (‘Heather’) voices which work with almost all text-to-speech programs on
Windows and MacOS computers.

These voices are licenced for school and home use for learners in Scotland. Many local authorities have
installed them on all their school computers as a reasonable adjustment under Equality and Accessibility
legislation, and also as a tool for all learners. If you don’t have them on your computers, ask your technical
service to download and install them.


http://www.thescottishvoice.org.uk/

Word Speak button

Word 2010 and 2013 have a free text-to-speech tool called ‘Speak’. To add it to the toolbar, follow the
instructions in the blog post here: http://www.callscotland.org.uk/Blog/Blog-Post/?reference=333.

Once you have the Speak button in the toolbar, select the text you want to read and click Speak, and the

text will be read out using the computer’s default voice. /
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Figure 4: Reading text with Word's Speak button

If you want to change the default voice or the voice speed, open the Speech Recognition Control Panel,
click Text-to-Speech, and choose the voice and settings you want to use. (If you cannot access the Control
Panels, contact your technical service or school ICT coordinatorl)
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Vaige speed
Slow Normal Fast
Audio Qutput ] [ Agvanced

Figure 5: Changing the default computer voice for Word Speak button
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WordTalk

WordTalk is a free add-on for Microsoft Word that gives more options and tools than the Word Speak
button. For example, WordTalk highlights as it reads so the learner can track the text; it lets you change
voices and voice speeds without having to access the Control Panels; it can read a word, a sentence or a
paragraph at a time; and learners who have difficulty with a mouse can use keyboard shortcuts. It also has
a talking spellchecker and you can save text as audio files (for playing back on an iPod, for example).

WordTalk works with most combinations of Word and Windows. You can download it free from the web
site: http://www.wordtalk.org.uk/.

Once you have WordTalk installed, click on the Add-Ins ribbon, place your cursor where you want to read,
and click the relevant WordTalk button to read the paragraph, sentence, word, or the whole text.
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Canned & Frozen

Canned and frozen veg count as well, so
try peas, sweetcorn and carrots. Adding
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Figure 6: Reading text with WordTalk

Other text-to-speech programs

There are many free and paid-for text to speech programs you can use —too many to cover them all here —
but we have listed some of the more popular tools below.

Text Readers

Text readers are mainly designed for designed for people who can see to click on or select text, and have it
read out by the computer.

iVona Simple toolbar for reading from anything — Word, PDF, Internet etc. Free
MiniReader

Natural Simple toolbar for reading from anything — Word, PDF, Internet etc. Free
Reader

MyStudyBar | A set of accessibility tools including a text reader. Free
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ClaroRead Comprehensive literacy support software. Text-to-speech; word prediction; From £49
talking spellchecker; easy font, spacing and colour adjustment; scanning etc.
http://www.clarosoftware.com/

Read and Comprehensive literacy support software. Text-to-speech; word prediction; From £320

Write Gold talking spellchecker; easy font, spacing and colour adjustment; scanning etc.

Co:Writer 7 | Word predictor with text-to-speech. £39 per
http://www.educationscotland.gov.uk/about/ordereducationresources/ licence

Penfriend Word predictor with text-to-speech. From £45
http://www.educationscotland.gov.uk/about/ordereducationresources/ per licence

Screen Readers

Screen readers are designed for blind people. They operate quite differently from text readers and read out
everything on the screen. They can all read Word documents.

NVDA Free screen reader that can read Word and PDF files, the internet, and allow | Free
a blind user to access the computer.

Jaws Screen reader that can read Word and PDF files, the internet, and allow a From £659
blind user to access the computer.

Supernova Screen reader that can read Word and PDF files, the internet, and allow a From £295

blind user to access the computer.

Answering questions on the text

As we noted earlier, the learner’s understanding of the text is usually assessed by asking questions with
reference to the outcome of the Unit. In this example, the questions might ask the learner to:

e give key information on the website;
e say who the website is aimed at, and why;
e comment on the layout of the website and it’s effectiveness.

The learner can use many different methods to respond to the questions, including:

o hand-writing;

e typing;

e dictating to a scribe;

e recording their answers as audio or video using a hand-held recorder;
e recording their answers as audio or video directly into the computer.

Because the questions are assessing reading skills, the learner could dictate answers to a scribe, or record
responses using audio or video.

If using ICT, the questions would normally be provided with the text in the Microsoft Word file, and the
learner would type answers directly into the Word document. Spellcheckers and other tools to support
writing such as word prediction can also be used.

CALL Scotland, University of Edinburgh
http://www.callscotland.org.uk
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